
APO Pro 
 

 Authorized Personnel Only 

 

 

Now that every website and login at your company requires a password containing a 

sixteen character combination of upper and lower case letters, numbers, Sanskrit, and 

squirrel noises, it is nigh on impossible to remember them all, or even just one. APO 

Password Manager is here to make those squirrel noises usable. 
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Getting Started with APO Pro 
 

1. Open the App.  You will be asked to create your Master Username and Password.  

This is the login credentials for your Personal password file.  You cannot skip this 

step; however, you may choose to leave this Personal password file empty after you 

have set it up. We suggest you start with a desktop / laptop version of APO. Once 

you are set up, you can sync your file with your Google Drive, and then simply 

download the file onto any other device you have APO loaded onto. 

 

Do not lose or forget your Username and Password.  If you forget your Username 

OR Password, all your data will be lost unless you have backed up your file as a 

plain text file.  There are no back-doors to accessing your data.  Your information is 

secure.  Unfortunately, that means it is even secure from you accessing it if you 

forget how to login.  Keeping a plain text file around with all your access codes is 

not a good idea, so, we recommend you print the file and save the printed copy of 

your password file in a “safe” place.  Then, shred the text file. 

 

2. Once you have created your Personal password file, you are then able to expand to 

additional password files created by you or shared with you via Google Drive.  Even 

if you do not want to use the Personal password file, we recommend that you keep 

the Username and Password for the other files you create or share in this Personal 

file.  How to create additional files will be covered in The Minutia section below. 

 

If you already have an APO password file on your computer and you want to 

download it to your iPhone from your Google Drive, skip ahead to section 5. 

 



 

3. With your Personal password file created, you can start populating it with 

information.  Medical numbers, Drivers License numbers, other ID numbers, login 

credentials for the various websites you visit, Facebook account info, email account 

information, WiFi access, and anything else you need to remember access 

information for on a regular or infrequent basis. 

 

4. Once you have created your Personal password file and populated it with 

information, you will want to back it up to your Google drive.   

 

a. On the main APO screen, click the Tools dropdown menu (the three stacked 

dots at the upper right of the screen on a phone) and select Sync with 

Google. 

b. Select Sync this Password File with Google Drive.  No, APO does not work with 

any other cloud drive at this time.  If you do not have a Google account, now 

is your opportunity to create one.  Even if you create an account specifically 

so you can use it with APO, you can use the email that comes with it for when 

companies or websites insist on you providing a valid email so they can spam 

you. 

c. When you are saving a file to Google Drive, you will be asked if Google Drive 

should allow APO to configure the drive.  You must answer “Yes” to this.  By 

allowing APO to configure Google drive, your password files saved there will 

only be visible to APO.  Even if your drive is hacked, the password files would 

not be visible to the hacker, so they cannot be selected and downloaded. 

 

5. To retrieve a password file created and stored on a Google drive: 

a. Open APO and enter your password to access your private password file.  

You only have to do this the first time you access the new file.  Once you 

have more than one password file in APO, you will be able to go directly to 

the file of your choosing. 

b. On the main screen, click the three stacked dots at the upper right to access 

the main menu. 

c. Select Retrieve a Password File from Google Drive. 

d. If you have registered any Google accounts with APO, then the 'Select Google 

Account' screen will be displayed.  If the Google account is in the list, select it.  

Otherwise click the plus icon in the upper right of the screen to go to the 

Google Account Name screen.  If you have not registered any Google 

accounts with APO yet, you will be taken directly to the Google Account 

Name screen. 



e. The Google Account Name screen will require you to enter the email address, 

then your Google password for access to the account.   

f. Finally, Google will ask you to confirm that you want to allow APO to access 

the Google account.  Allowing APO to access the Google account will give it 

access to the hidden APO file that you want to download to your iPhone.  The 

file is hidden so you will not see it if you use your browser to access this 

Google drive. 

g. Once you have selected the account, or added it, you will be shown a list of 

password files available in the account.  Select the required file and it will be 

downloaded to the device.   

h. You can then open the downloaded password file by selecting the 'Open 

password file' menu entry from the main menu on the main screen (3 vertical 

dots). 

 

The Minutia 
 

At this point you should have APO up and doing everything you expected and perhaps a 

little more than you expected from your password manager.  You could happily stop now 

and be perfectly content with APO.  Perhaps even pleased enough to share your discovery 

with friends or family? 

 

But wait, there’s more! 

 

Easier Ways to Open APO: Biometrics or Just the Password 
 

There was a reason why we created APO so that it could safely communicate across 

platforms.  Typing on your desktop or laptop is a lot easier than typing on your iPhone.  

You can enter your credentials using a full keyboard, and then send the file to your 

iPhone.  That beats using a single finger on a tiny phone keyboard! 

 

The same issue arises every time you want to access a file in APO.  You must use that tiny 

keyboard to enter you Username and Password.  For those of you who find this irksome, 

and are content with a little less security in exchange for a little more ease of use, you can 

set your phone APO to only require the password portion of your credentials. 

 

Click the three vertical dots in the top right and choose Settings.  From there you can touch 

the check-box to the right of Open with fingerprint. But as we all know, there are occasions 

when your not yourself and your phone does not believe you are you. On those occasions 



you will still have to enter your credentials.  But we are all in a hurry and once we are used 

to opening things with a simple touch of our thumb, actually having to type something can 

be excruciating.  So …  

 

For those occasions when you are not yourself, you can choose another option. Touch the 

check-box for Open with password and voila, you are instantly less secure, but somehow 

happier!. Now you can open your APO without having to type in that pesky username. You 

aren’t a spy. You don’t work for the Defense Department. Real security is for shmucks! I 

want the easy solution. 

 

While you are in there, you can play with some of the other settings like the text size that 

APO uses to display your information. 

 

We will be developing biometrics for Windows Hello soon. Please be patient. 

 

Copying and Pasting your Username and Password 
 

In order to easily copy your credentials for pasting into a website login page, simply place 

and hold your finger on the name of the entry you want to access (phone or tablet) or 

right-click the entry (PC or Mac).  For example, if you want to retrieve your credentials for 

your Amazon account, you do not click on the entry for Amazon.  Instead, you touch and 

hold on Amazon and a menu will come up where you can choose from the following 

options: 

 

• Copy user name to Clipboard (phone) 

• Copy password to Clipboard (phone) 

• Copy password and open website 

• Copy selected Cell to Clipboard (PC/Mac) 

• Open Website and autotype credentials (PC/Mac) 

• Autotype Credentials (PC/Mac) 

• Pin to Top 

• Edit Entry (PC/Mac) 

• Delete Entry 

• Move Entry 

• Share Entry (On a PC/Mac, it will ask for a security question and answer, and then 

encrypt a file that you can email. The recipient must have APO.) 

• Share Entry by QR Code (this can be scanned into a phone that has APO) 

• Add to Group (PC/Mac) 

 



On a phone, once you have copied to the clipboard, touch and hold where you want to 

paste the copied material and the option to paste will pop up. 

 

Searching Your Entries 
 

APO provides a search function so you can find that information you saved, but only 

remember something you put in a note as part of the entry. You can access the search 

function by choosing the Entry drop down menu and selecting Find. On a phone, choose 

the magnifying glass on the top right. 

 

Alternatively, you can use the shortcut keys shown next to that entry: Ctrl F for PC and ⌘ 

F on Mac 

 

Opening APO using Biometrics (thumb print or, coming soon, face 

scan) 
 

Life just got easier. With this function, you can open APO as easily as you open your 

phone. 

 

Organizing Your Passwords 
 

 Grouping 

Grouping your entries may be a good way to keep things organized. APO has already 

provided the major groups as tabs across the top but over time, these entries add up and 

you may find yourself wanting to group some of these just to clean things up. Even just 

having a group called “Seldom Used” will make finding your regularly used entries easier 

to find. Creating groups is only possible on the desktop / laptop version of APO. Again, 

doing this is easy when you are using a full keyboard and mouse. On your phone, you can 

see and use the groups you created on your desktop. 

 

 Pinning 

There is always a couple of entries that you use regularly (the 80/20 rule). For those few 

entries, you can Pin them to the top of the list. This will take them out of the alphabetic 

listing and keep them pinned to the top for quick and easy access. 

 

Gift Cards 
 



It currently works, just not with all systems – it is a work in progress.  

 

In addition to gift cards, you can scan in coupons, theater tickets, and virtually anything 

else with a barcode or QR code. If the code does not want to scan in, you can manually 

enter the number and APO will generate a barcode for it. 

 

In addition, you can keep track of balances for your gift cards on APO. 

 

2-Step Verification 
 

You can download your 2-step verification code generator onto your phone by scanning 

the QR or Barcode supplied by the site requiring 2-Step verification. 

 

Once on your phone, you can sync it with your computer.  

 

Any time you need a code, select it on your phone and it will be displayed along with a 

countdown timer showing how long the code is valid for. On your computer, the code is 

automatically displayed in the Code column. To update the code on your computer, you 

will need to toggle to another category in APO and then back to 2-Step Verification. 

 

Crypto Currency 
 

With APO Password Manager you can keep your crypto currency safely on your own hard 

drive instead of at an exchange. The exchanges are honey pots for hackers and despite 

Herculean efforts, they have lost tens of millions of dollars worth of crypto-currency over 

the years. 

 

Using APO to keep your cryptocurrency keys, you maintain control and so long as you 

maintain some simple security protocols, your money will remain safe. With 

cryptocurrency, you have two keys, your primary key which holds all of your currency and 

is never-ever given to an exchange, and a secondary key. When you want to convert 

cryptocurrency into cash, you do an offline transaction using a wallet (like MyEtherWallet), 

sending the desired amount from your primary key (savings) to your secondary key 

(chequing).  Use the offline transaction to send money from your savings to your 

chequing, and then use an exchange to cash out the chequing account.  The most you 

would ever be able to lose then is what is held by your secondary key, and, said key 

doesn't hold any currency for long. 

 



 

For the Power Users! 
 

Creating Additional Password Files 
 

APO allows you to create as many password files as you need.  In addition to your 

Personal file (where you would keep the Username and Password for any additional files 

you create), you can create a shared file called Family, or a dedicated work file called 

Work. 

 

If you are working for a client in a collaborative environment where you need to share 

login credentials with temporary contractors, or co-workers, you can create a file 

specifically for that client and share it with that specific group. 

 

To create a new password file, click the three vertical dots in the top right and choose New 

password file.  Give your new file a name, enter your login credentials and you have a new 

file ready to be populated with secrets.  At this point you should enter these details in 

your Personal file, just in case. 

 

You can then upload this file you your Google Drive, or perhaps a company Google drive 

set up for sharing password files.  Invite your co-workers to download the file and you will 

have to give them the login credentials (preferably not via email).   

 

If you have multiple password files on the shared Google Drive, your co-workers using 

APO will be able to see all the APO files you have stored there.  They will not, however, be 

able to open them unless they have the Username and Password that is (or should be!) 

unique to each file. 

2-Step Verification 

 

Once you have proven you have access to this shared file, in the future, when logged into 

your Personal File, you are able to open any other file that you have created or have 

opened previously, provided that file is on your hard drive. This single sign-on feature 

allows you to quickly and easily move between different password files. However, if you 

try to sync a file (other than the personal file you have already logged into) with the file 

kept on a Google drive, the file kept in the cloud will require you to enter the credentials 

for that file to ensure that you are still allowed to access updates to that potentially 

shared file. 



 

Encrypting a File (Desktop and Android only) 
 

APO has a file encryption function (PC/Mac) that will allow you to encrypt a file, or multiple 

files.  Choose the File dropdown menu, and then Encrypt.  A browse screen will appear 

where you can browse to the file(s) you want to encrypt.  Click on the file, and use the 

Shift key and click on other files you want to include.  Click the Open button and an 

encrypted copy of the selected files will created.   

 

If you have multiple password files, open the password file you want to use to complete 

the encryption.  If you choose a password file that you share with others, then you can 

send that encrypted file to those people and they can use APO to decrypt it using the 

shared Username and Password. 

 

To decrypt a file, Choose the File dropdown menu, and then Decrypt.  A browse screen 

will appear where you can browse to the file(s) you want to decrypt.  Click on the file, and 

use the Shift key and click on other files you want to include.  Click the Open button and a 

decrypted copy of the selected file(s) will be created. 

 

When you are logged in, APO will automatically choose the correct password file for the 

decryption process. 

 

Hashing a File (Desktop and Android only) 
 

For the security minded among you, APO has a hash function that will allow you to hash a 

file and compare it to an earlier hash.  This is the same function that is used by Blockchain 

systems for detecting errors and ensuring files have not been tampered with. 

 

If you need to ensure that a file isn’t tampered with when transferring it over the internet, 

you may take a hash of that file by choosing the File dropdown menu and then Hash.  A 

browse screen will appear and you can choose the file or folder full of files that you want 

to hash.  Once selected, you can then choose the Hash Type:  SHA-256, SHA-1 or MD5. 

 

Click the Compute Hash button and the result with appear in the Result window.  You may 

then send that result separately to the recipient.   

 



The recipient can then hash the file they received by following the same procedure as 

above.  They then copy and paste your hash into the Compare with window.  The result of 

the comparison will be displayed next to the Compare With header. 

 

If the hashes match, the files are identical.  If they do not match, the file was tampered 

with during the transit from the sender’s computer to the recipient’s computer. 

 

 

Troubleshooting  
 

My Auto-Type Credentials function isn’t working. 

In order for your auto-type function to work, your computer must allow APO to 

execute certain functions automatically. These functions sometimes require the use 

of features that are built into your operating system.  

On a Mac Computer, you will have to open your System Preferences window, select 

Security & Privacy. Click the lock on the bottom left to allow you to make changes. 

Check the box to allow APO to control your computer (sounds more ominous than 

it is). 

 


